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The Lake Michigan shore in northern Sheboygan County consists of steep bluffs
approximately 50 feet in height. Long term recession rates of approximately two feet per
year have been recorded along this segment of the shore. Storms and high water levels in
the Great Lakes accelerate shoreline erosion and bluff erosion and increase flooding and
property damages. During 1985-86, Lake Michigan set new record marks for high water
levels in the 20th century, leading to unprecedented property damage. Recently, water
levels in the Great Lakes have increased to a level that begins to concern the U.S Army
Corps of Engineers.

In order to discourage development in erosion hazard areas, preserve shore cover and
natural beauty and meet other public objectives, Sheboygan adopted a ShorelandFloodplain Ordinance on October 27, 1970. The ordinance regulates development within
1000 feet of the ordinary high water mark of navigable lakes, ponds, flowages, and
specified wetlands; 300 feet of navigable waterways; and within the 500 year floodplain.

Geographic information systems (GIS) may be utilized to more effectively manage
development in the coastal zone. This GIS application assesses coastal erosion impacts
and explores management issues related to shoreland development in the Town of Mosel
in northern Sheboygan County.
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General Instructions
These instructions are divided into seven sections. They are designed to be followed from
front to back (i.e. Section One first, then Section Two, etc.). Earlier sections contain
descriptions of basic ArcGIS 9.2 operations. They also create layers that will be used in
the later sections.
As you move through the application, you may need to refer back to earlier descriptions
for performing a particular function. The Table of Contents is designed to help you move
back and forth through the document.
1. Inputting and viewing existing databases. ...................................................................... 4
Create a document and a view. ..................................................................................... 4
Add data files to view. .................................................................................................. 4
2. Modifying existing layers. .............................................................................................. 7
Create new layers from the Planimetric Map. .............................................................. 7
Modify the parcel map to create unique parcel identification numbers........................ 9
3. Creating a map of the jurisdiction of the Shoreland Zoning Ordinance. ...................... 13
Create a new data frame.............................................................................................. 13
Add a field describing shoreland zoning jurisdiction distances.................................. 13
Create shoreline jurisdiction zones using the buffering operation.............................. 15
Create a map of the Shoreland Zoning Ordinance Jurisdiction. ................................. 16
4. Evaluating potential Lake Michigan erosion impacts................................................... 19
Part I: Creating a map of the current stable slope, and projections of future shoreline and
bluff edge locations........................................................................................................... 19
Extract a Lake Michigan shoreline layer. ................................................................... 19
Create a map of the bluff edge as the current bluff erodes to a stable angle. ............. 20
Create a map of the projected shoreline location after 50 years of recession............. 22
Create a map of the required setback from the Lake Michigan shoreline. ................. 22
Part II: Determining land and buildings at risk................................................................. 23
Identify high risk land areas and buildings based on stabilization of the slope at its
current location. .......................................................................................................... 23
Identify moderate risk land areas and buildings found between the current stable slope
location and the Ordinance setback zone.................................................................... 25
Identify at-risk land areas and buildings within 50 feet of the setback. ..................... 28
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Estimate impacts to buildings from bluff edge recession. .......................................... 38
Estimate the impacts to roads from bluff edge recession............................................ 39
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Set up a hot link to the file containing the sediment loss formula.............................. 41
Calculate the sediment loss from shoreline recession and bluff stabilization............. 43
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Calculate the amount of developable land for each parcel. ........................................ 49
Chart the amount of developable land on vacant, lakeshore parcels. ......................... 52
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1. Inputting and viewing existing databases.
In this section, you will input and view five data sources -- floodplains, parcel boundaries,
township zoning, a planimetric map and an orthophoto.

Create a document and a view.
From the ArcMap File menu, choose New… Select Blank Document and
click the OK button. An empty map screen will appear untitled.
From the View menu, choose Data Frame Properties to display the Data
Frame Properties dialog box. Click General tab, highlight the name
Layers and type in “Data Layers” as the new name for this Frame. Click
Coordinate System tab and set the coordinate system to “NAD 1983
HARN Adj WI Sheboygan Feet” under “Predefined > Projected
Coordinate Systems > County Systems > Wisconsin.” (The data are in
the Sheboygan County Coordinate System). Click OK.
Throughout this application, names will be provided for data frames, layers,
files, etc.. You may choose to use other names. However, references to
suggested file names will be made in later sections of the application so it
will work best if you use the names provided.

From the File menu, choose Save As.... Locate the directory where you
wish to save your data. In the file Name input box, type a name for your
document. Click OK.
An ArcMap document file is assigned the extension “.mxd”. A document
can contain multiple data views, attribute tables and a layout. For this
Shoreland Zoning Applications model, all our work will be saved under a
single document. You may wish to adjust this according to your data storage
needs.

Save your work frequently (select Save under the File menu)! If the ArcMap program
crashes, you can lose any changes made since your last save. If ArcMap does crash and
the document was recently saved, it will be very easy to recreate where you left off by
simply opening the document.

Add data files to view.
Click the Add Data button to add data files as layers into your view.
Locate and highlight the following files and click OK: mosflood.shp,
mospar.shp, mosplan.shp and moszone.shp. Click OK in the ‘Unknown
Spatial Reference’ warning window that appears. To add the digital
orthophoto for the northern section of the township, click the Add Data
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button again; this time add the file called “moseldoq.tif.” Click Yes in the
‘Build Pyramids’ dialog/prompt that appears and the orthophoto will draw.
To rename the layers, click on a layer name to make it active. When a
layer is active, the name is highlighted by blue color in the Table of
Contents. Right click on the layer name and choose Properties. In the
layer Properties dialog box, click General tab. Highlight the current layer
name, type a new name and click OK. Rename the layers:
“mosplan.shp” to “Planimetric Map”
“mosflood.shp” to “Floodplains”
“moszone.shp” to “Town Zoning”
“moseldoq.tif” to “Orthophoto”
“mospar.shp” to “Mosel Parcels”
Click on the box in front of each layer to make the layers visible on the
screen.
Layers are drawn based on the order they appear in the Table of Contents.
In order to view a layer, you may need to move it above another layer. To
do this, click on the name of the layer to make it active and drag it to a
new site on the Table of Contents.
The Zoom to layer can be used to zoom the view to Mosel Township
(right click on the name of any Township layer in the Table of Contents
and choose Zoom to layer). You can also use the Zoom In button to
focus on a smaller section of the view. Use the Full Extent button to
view all the data of all the layers.
Zoom to layer
Zoom In
Full Extent

To display the Town Zoning layer by zoning codes, double click on the
layer to bring up the Layer Properties dialog box and click on the
Symbology tab (Figure 1). In Show frame, choose Unique Values under
Categories class. For Value Field, choose Zoning then click Add All
Values button. To change how each of these categories are labeled in the
view, click each Label field in the symbol list box, then highlight the
current Label description and change:
“A-1” to “Prime Agricultural”
“A-2” to “General Agricultural”
“B-1” to “Business”
“C-1” to “Conservancy”
“I-1” to “Industrial”
“R-1” to “Single Family Residence”
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“R-2” to “Two Family Residence”
“R-3” to “Multiple Family Residence”
Uncheck the box in front of the symbol of <All other values>. Click
Apply in the dialog box to apply your changes to the view. Close the
Layer Properties dialog box.

Figure 1. Symbology page in Layer Properties dialog box

Save your document.
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2. Modifying existing layers.
In this section, you will create new data layers (parcels, transportation, hydrography,
buildings, cemeteries and the bluff edge) by extracting information from existing layers.

Create new layers from the Planimetric Map.
The Planimetric Map layer has a data field called “lgds_level”. The codes in this field
distinguish line segments in the map according to their feature type. To display these
individual features, you will need to query the associated database (attribute table) for
specific criteria. This information can be stored in a query format or it can be used to
create a new layer in the ArcGIS shapefile format.
A shapefile is an ESRI GIS format for storing geometric and attribute information on a
feature. When data in other spatial formats are converted into shapefiles, they maintain
the extent and units from the original format. When a new shapefile is created, the extent
and units of the new features are determined by existing themes within the view. Although
a shapefile has geometric references, it does not have topology. Therefore, there may be
limitations when using shapefiles or exporting them into another GIS software program.

To create a layer with information on roads and railroads, make the
Planimetric Map layer active. Double click on the name of Planimetric
Map layer in the Table of Contents. In Layer Properties dialog box, click
Definition Query tab and click Query Builder button to bring up the
Query Builder dialog box (Figure 2).
From the Fields list, double-click lgds_level; this now appears in the
expression box. Next, you want to set this equal to a value (click once on
the ‘=‘ sign). Click Get Unique Values button. From the Values list,
double click ‘1’. Click once on the ‘or’ button to continue building the
query. Return to the Fields list and repeat the procedure for the values
‘2’,’3’,’4’ and ‘20’. Your finished query should look like this:
( "IGDS_LEVEL" = 1 ) OR ( "IGDS_LEVEL" = 2 ) OR
( "IGDS_LEVEL" = 3 ) OR ( "IGDS_LEVEL" = 4 ) OR
( "IGDS_LEVEL" = 20 ). Click OK in the Query Builder and Layer
Properties dialog boxes. Your view will now display only the
transportation features of the Planimetric Map.
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Figure 2. Query Builder
To convert this into a new layer, right-click on the Planimetric Map, point
to Data and choose Export Data… Choose a directory and name the file
“mostrans.shp.” Click OK. (Figure 3). Answer Yes to add this shapefile to
the map. Change the layer name to “Transportation Routes.”

Figure 3. Export Data
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You now have two layers which appear to have the same information.
However, the Planimetric Map layer still contains all its original
information but, because of the query, is displaying only a portion of
these features. To clear this query, delete the query expression in the
Definition Query page in the Layer Properties Dialog Box of the
Planimetric Map layer, then click OK.

To create a layer with information on buildings, build the following query
on the Planimetric Map layer: ( "IGDS_LEVEL" = 6 ) OR
( "IGDS_LEVEL" = 8 ) OR ( "IGDS_LEVEL" = 60 ). Create a
shapefile, save the file as “mosbldg.shp,” add it to your view and rename it
“Buildings.”
To create a layer with information on water bodies, make sure the last
query is cleared then build the following query on the Planimetric Map
layer: ( "IGDS_LEVEL" = 12 ) OR ( "IGDS_LEVEL" = 13 ). Create a
shapefile, save it as “moshydro.shp,” add it to your view and rename it
“Hydrography.”
To create a layer with information on cemetery locations, build the
following query on the Planimetric Map layer: ( "IGDS_LEVEL" = 15 )
OR ( "IGDS_LEVEL" = 27 ). Create a shapefile, save it as
“moscult.shp,” add it to your view and rename it “Cemeteries.”
Remember to clear the Planimetric Map layer’s query.

Modify the parcel map to create unique parcel identification numbers.
You will now extract a separate layer for mapping parcel ownership in the Township.
The new layer will be used for the rest of this application.
The file “mospar” contains the digital parcel map for the Town of Mosel. If you look at
the individual records, you will find that some parcels (i.e. polygons) have identical
parcel identification numbers. Using this database will cause problems in subsequent
analysis, particularly when you try and link the database to other files. The best remedy
for this situation would be to assign unique parcel identification numbers to each parcel.
However, this is the job of the county records-keeper and not the GIS analyst. Another
solution is to merge parcels with identical parcel IDs and create a separate layer. By
doing this, you can now use the spatial attributes of the parcel file in combination with
non-spatial attributes (e.g. owner’s name) found in other files. The downside of this
solution is that some information will be missing in your new file. Specifically, if two
identically-numbered parcels are adjacent to each other, the line separating the parcels
will disappear. In addition, two parcels that share identification numbers but are not
adjacent will combine into one, non-contiguous feature.
Click Show/Hide ArcToolbox Window button to open the
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ArcToolbox window (Figure 4). Click the plus sign in front of Data
management Tools and Generalization to expand the sub-items.
Double-click on Dissolve to open the Dissolve geoprocessing dialog box
(Figure 5). In the dialog box, choose Mosel Parcels layer from the
drop-down list box as the Input Features. Save the Output Feature
Class file name as “Parcels.shp” with full path. Check Shape (this field is
not listed w/9.2) and PARCEL_ID fields in Dissolve_Field(s) list box.
Choose AREA field from the Statistics Field(s) drop-down list box. The
AREA field is added to the list box by itself. Select SUM Statistic Type
for AREA field in the list box. Make sure Multipart is checked and then
click OK. The dissolve operation is now processing. Wait for completion
and close the dialog box. The new layer is added to the Data Layers frame.
Make sure the layer is renamed to “Parcels.” Close the ArcToolbox
window.

Figure 4. ArcToolbox

Figure 5. Dissolve dialog box
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In other words, you have merged parcels with the same identification
number and calculated the area of any new parcels equal to the sum of its
component parcel areas.
When a layer is first created, it is displayed in a single color. With the Symbol Selector,
you can modify how the layer is displayed. For this view, you will want to display only
the outlines of the parcel layer. By making the non-outline portions transparent, you will
be able to view other layers under this data layer.
Open the Parcel layer’s Symbol Selector (Figure 6), by clicking on the
rectangular symbol under the Parcel layer in the Table of Contents. The
Symbol Selector is now displayed. In Options frame in the dialog box,
click on the Fill Color button and choose No Color. This indicates a clear
foreground. Click on the Outline Color button and click on your preferred
choice from the colors displayed. Click OK to close the Symbol Selector.

Figure 6. Symbol Selector
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You may wish to remove the Mosel Parcels (Mospar.shp) layer from your
view. To do this, right click on the Mosel Parcels layer in the Table of
Contents. Choose Remove from the context menu. This command
removes the layers from your data frame and view but does not delete
saved files from your directory.
Save your document.
The ArcGIS 9.2 Buffer wizard
The ArcGIS 9.2 Buffer Wizard has been removed from the ArcMap Tools menu, but it is still accessible if
you click Tools, click Customize, click Tools in the Commands tab, and select Buffer Wizard. If you want
to use this wizard, you can add it to any ArcMap toolbar or pulldown menu from the Customize dialog box.
You may want to do this to buffer graphics drawn on a map.
Locating the 9.2 Buffer Wizard operations in the ArcToolbox window
y To buffer at a specified distance or based on distances taken from a field— Analysis toolbox >
Proximity toolset > Buffer tool
y To buffer creating multiple rings— Analysis toolbox > Proximity toolset > Multiple Ring Buffer
tool
NOTE: In the Buffer tool, the Side Type option is restricted to FULL and the End Type option is restricted
to ROUND if you are using an ArcView or ArcEditor license. Setting the Side Type to LEFT or RIGHT
and setting the End Type to FLAT, are only possible if you are using ArcInfo.

The ArcGIS 9.2 Geoprocessing wizard
The ArcGIS 9.2 Geoprocessing Wizard has been removed from ArcMap; it is no longer provided in the
product.
Locating the 9.2 Geoprocessing Wizard operations in the ArcToolbox window
y Dissolve— Data Management Tools toolbox > Generalization toolset > Dissolve tool
y Merge— Data Management Tools toolbox > General toolset > Append tool
y Clip— Analysis toolbox > Extract toolset > Clip tool
y Intersect— Analysis toolbox > Overlay toolset > Intersect tool
y Union— Analysis toolbox > Overlay toolset > Union tool
NOTE: In the Union and Intersect tools, only two inputs are allowed if you are using an ArcView or
ArcEditor license. The ability to union or intersect more than two inputs is only available if you are using
an ArcInfo license.
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3. Creating a map of the jurisdiction of the
Shoreland Zoning Ordinance.
In this section, you will create areas of shoreland zoning jurisdiction along lakes and
rivers, along with a map displaying this information. You will also learn how to access a
help file containing the text from the Ordinance document.

Create a new data frame.
From the Insert menu of ArcMap, choose Data Frame to create a new data
frame. Rename it to “Shoreland Zoning Ordinance.” Set the coordinate
system to “NAD 1983 HARN Adj WI Sheboygan Feet”. You can copy a
layer between data frames, preserving the colors and other properties from
the original layer. Under the Data Layers frame, select the Parcels and the
Hydrography layers
.
In order to select multiple layers, simply hold down the Control key and
select each layer. All selected layers should be highlighted by blue color.

Right click on any of the selected layers, choose Copy from the context
menu. Now, click on the Shoreland Zoning Ordinance frame, then right
click on it and choose Paste Layer(s) from the context menu. Click on the
plus sign in front of the Data Layers frame to collapse all sub items.
Make the Shoreland Zoning Ordinance frame active by right clicking on it
and choose Activate in the context menu. Make the Hydrography layer the
only visible layer. Open the Hydrography’s Layer Properties dialog box
and click on Symbology tab. In Show list box, select Unique values
under Categories class. Choose IDGS_LEVEL in the Value Field then
click Add All Values button. Two values will be displayed. Label the
value “12” as “Lakes and Ponds.” Label the value “13” as “Rivers and
Streams.” Uncheck the box in front of the symbol of <all other values>.
Close the Layer Properties dialog.

Add a field describing shoreland zoning jurisdiction distances.
Based on the Shoreland-Floodplain Ordinance, zoning jurisdiction for navigable waters is
determined by the feature type (Lakes and Ponds = 1000 feet, Rivers and Streams = 300
feet).
Right click on the Hydrography layer and choose Open Attribute Table to
access the attribute data. Click the Options button in the attribute table
and choose Add Field… Name your field “Distance.” This will be a
Short Integer field; you can adjust the size of the field under Precision.
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In this case, keep the default settings and click OK.
Click the Options button and choose Select by Attributes. Construct the
query: ("IGDS_LEVEL" = 12). Make sure Create a new selection
method is selected and click apply. Data satisfying this query will now be
highlighted in the attribute table. Close the Select by Attributes dialog box.
Click the Selected button at the bottom of the attributes window to show
only selected records.
Right click on the Distance field in the attributes table and choose Field
Calculator… Click Yes to confirm the operation. In Field Calculator
dialog box, type in “1000” in the expression box at the lower window and
click OK (Figure 7).

Figure 7. Field Calculator
Click All button to show all records. Clear the selection by choosing Clear
Selection in the Options context menu. Repeat the above procedure to
construct the next query: ("IGDS_LEVEL" = 13) and give these data the
Distance value “300.” You can view the result in the attributes table, then
close it.
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Create shoreline jurisdiction zones using the buffering operation.
Click Show/Hide ArcToolbox Window button to open the
ArcToolbox window. Click the plus sign in front of Analysis Tools
and Proximity to expand the sub-items. Double-click on Buffer to open
the Buffer geoprocessing dialog box (Figure 8). In the dialog box, choose
Hydrography layer from the drop-down list box as Input Features. Save
the Output Feature Class file name as “Buffers.shp” with full path. Click
on Field radio button and choose Distance field. Set Dissolve Type to
List and check Shape field in the Dissolve_Field(s) list box (the Shape
field is not listed w/9.2—didn’t check any boxes, thus buffer op will NOT
work). Click OK to create buffers. After completion, close the dialog box
and ArcToolbox. The Buffers layer is already added into the data frame. If
not, click Add Data button to add it. Rename it to “Shoreland Zones.”
If you have trouble creating the buffers, try closing your document, then
reopening it and doing the process again.

Figure 8. Buffer dialog box
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When ArcMap creates a buffer for a line segment, it locates the buffer a
specified distance on both sides of the line. On both ends of the line segment,
it forms a half circle which connects the two sides of the buffer. This half
circle is located the specified distance from the line endpoints. If you create
a buffer from a multi-segmented line, you will see a series of circular buffers
where the line segments meet.

Create a map of the Shoreland Zoning Ordinance Jurisdiction.
Although you now have a display of this data on your computer screen, you will want to
use the Layout capabilities of ArcMap for creating mapping products. These layouts can
contain views, tables, charts, scanned pictures and other graphic elements. They also can
contain legends, north arrows, scale bars and additional text.
Make the layers Hydrography, Parcels and Shoreland Zones visible.
Display them in the colors you wish for your map product. From the View
menu, choose Layout View. From File Menu, choose Page and Print
Setup… (Figure 9). Set your Map Page Size or check Use Printer Paper
Settings.

Figure 9. Page and Printer Setup
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In this application, we have two data frames in the document. So we see
two data frame objects on the page. Select, resize and move them until you
like the arrangement on the page. If you just want to print one data frame,
move the data frame object, which you don’t want to print, out of the page
extent and leave there. Remember not to delete it. If you delete the data
frame object on the layout page, it will also remove the data frame we had
created in the document.
If you are happy with the layout, you are now ready to export or print.
Check the page and printer setup settings by selecting Page and Print
Setup… under the File menu. If you wish to export the map, choose
Export Map… under the File menu. An Export dialog box prompts you
to choose a filename to save the output. If you wish to print the file,
choose Print Preview… under the File menu. Click Print button to open
the print dialog box when you are ready to print.
ArcMap 9.x does not support multiple layouts in a document. This means
you can only create a layout in a ArcMap document. If you want to create
two or more layouts, you have to save your document as other files when
you create your second layout. Therefore, you can have two different layouts
in two separate ArcMap documents.

You may wish to modify the default layout. The following instructions
highlight some of the graphic formatting options available.
To select a feature for editing, click the Select Element button on the
drawing tools pad, then click the feature. When a graphic is selected, it will
be surrounded by an invisible box bordered by four squares. It can now be
resized using the two-directional arrows or moved by simply dragging the
box to the desired location. You may need to move other graphics around to
make room for your selected graphic. To add a feature, click the
button for graphics. Now, click the mouse on the
button for text or
location where you wish to add the graphic.
Select Element

Draw Graphics

Add Text

You could also add some basic map elements from the Insert menu
(Figure 10). They are Title, Text, Neatline, Legend, North Arrow, Scale
Bar, and Scale Text. Just follow the dialog box, change some settings or
choose the element style you like, then click OK. The element will be
inserted on the page.
From the View menu, choose Data View. Save your document.
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4. Evaluating potential Lake Michigan erosion
impacts.
In this section, you will identify potential impacts from the erosion of the Lake Michigan
coastline. Based on parameters outlined in the Shoreland-Floodplain Ordinance, you will
estimate the new location of the bluff edge as the current slope stabilizes (Part I). In
addition, using a 50-year time frame, you will project the future location of the shoreline
and bluff edge. From these projections, land and buildings at risk will be identified (Part
II). In addition, economic impacts to land and building values will be estimated (Part III).
You will also examine potential impacts to nearby roads. The final analysis will focus on
sediment loss from erosion of the 50-foot bluff (Part IV).

Part I: Creating a map of the current stable slope, and projections of
future shoreline and bluff edge locations.
Extract a Lake Michigan shoreline layer.
All estimates of recession are based on the current location of the shoreline. This layer
will be extracted from the broader hydrography database.
Switch to data view and activate the Shoreland Zoning Ordinance
data frame. Make the Hydrography layer visible and other layers
invisible. Click the Select Features button and then click on a section of
the shoreline, highlighting it in cyan. Holding down the shift key, continue
clicking on the shoreline until the entire shoreline is selected. Right click
on the Hydrography layer, point to Data in the context menu and choose
Export Data… Export selected features to a shape file and save as
“lakemich.shp” (Figure 11). Click Yes to add it to your map as a layer and
rename it “Lake Michigan Shoreline.” Choose Clear Selected Features
from Selection menu.

Figure 11. Export Data
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Insert a new data frame and copy the following layers from previous data
frames: Buildings, Transportation Routes, Orthophoto, Parcels and Lake
Michigan Shoreline. Make this data frame active, name it “Shoreline
Recession Scenarios” and set the map coordinate system to “NAD 1983
HARN Adj WI Sheboygan Feet”.

Create a map of the bluff edge as the current bluff erodes to a stable
angle.
The Ordinance defines a stable slope angle as 2.5 feet of horizontal distance for every one
foot of vertical distance. In this area of the County, the average bluff is 50 feet high.
Therefore, the location for the top edge of the bluff, based on a stable slope, will be 125
feet inland from the shoreline. You will use the buffer operation to create a 125-foot
buffer from the shoreline. The inland line of the buffer is an estimation of the bluff edge
location based on the current shoreline.
Create a buffer around the
Lake Michigan Shoreline
layer named “buff_125.shp.”
Click Show/Hide ArcToolbox
button to open the ArcToolbox.
Choose Buffer command to open
the Buffering dialog box. Select
Lake Michigan Shoreline layer
as Input Features and type in
“buff_125.shp.shp” with full
pathname as Output Feature
Class. Set Distance 125 feet,
choose List for Dissolve Type
and check Shape filed in
Dissolve_field(s) list box. Click
OK to create the buffers (Figure
12). Add buff_125.shp to your
data frame if it is not added by
ArcMap. (Shape not available as
Dissolve_Field again?)

Figure 12. Buffer dialog box

Feb 9, 2007

Coastal GIS Applications -- Town of Mosel (ArcGIS 9.2)

Page 21

You can improve the look of your buffer is to clip off the portion of the polygon that
extends both 125 feet into Lake Michigan and out from the endpoints of the shoreline line
segment. You will do this with the help of another geoprocessing function, Clip, which
will clip a point, line or polygon layer to the size of another polygon layer.
Double click Clip command under Analysis Tools and Extract categories
in ArcToolbox window to open the Clip dialog box. In the dialog box,
choose the buff_125 layer as Input Features and Parcels layer as Clip
Features. Save the Output Feature Class as “sta_bluf.shp”. Click OK to
process (Figure 13). In other words, the buffer will be clipped to the area
where it overlaps with the parcels data (i.e. the land). Add sta_bluff.shp to
your data frame if ArcMap doesn’t add it. Rename it “Current Stable
Bluff,” and display only the outline of the buffer. Delete the buff_125.shp
from your data frame.

Figure 13. Clip dialog box
Now, move the Lake Michigan Shoreline layer to the top of the data frame.
The inland line of the buffer visually represents the bluff edge estimation.
If you zoom in on the Orthophoto, in certain areas you will be able to discern the current
location of the bluff. Compare this with your estimation of the stable bluff location.
Because the stable slope angle will actually vary depending on the underlying geological
makeup of the slope, it is appropriate to think of the future bluff as falling somewhere
within a range of locations around the setback estimation.
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Create a map of the projected shoreline location after 50 years of
recession.
The setback distance described in the Shoreland-Floodplain Ordinance is based on a
longterm shoreline recession rate of two feet per year for the northern half of Sheboygan
County. Because the Ordinance considers a 50-year period to be the “useful life of a
typical residence,” you will use this time interval as a basis for your analysis. In other
words, the location of the Lake Michigan shoreline in 50 years is projected to be 100 feet
inland from its current location. You will use the buffer operation to create a 100-foot
buffer from the shoreline. The inland line of the buffer is an estimation of the future
shoreline location.
Create a buffer around the Lake Michigan Shoreline layer named
“buff_100.shp.” Set Lake Michigan Shoreline layer as Input Features
and distance as 100 Feet. Select dissolve type as List and check Shape
field in the buffer dialog box. After the buffer created, clip this buffer to
the Parcels layer, saving the file as “pred_shr.shp.” Add the layer to your
view and rename it “50-year Shoreline.” Delete the buff_100.shp files.

Create a map of the required setback from the Lake Michigan
shoreline.
The total setback in northern Sheboygan County is based on both the recession of the
shoreline and the stabilization of the slope. This distance totals 225 feet from the Lake
Michigan shore. In order to map the setback requirements, you will use the buffer
command to create a buffer from the current shoreline. The inland line of this buffer is
one way to estimate the location of the bluff edge in 50 years. It will also illustrate the
Lake Michigan setback requirements in the Ordinance.
Double click Buffer in the ArcToolbox to open the Buffer dialog box. Set
Lake Michigan Shoreline layer as Input Features and distance as 225
Feet. Select dissolve type as List and check Shape field in the buffer
dialog box. Save your file as "buff_225.shp” and click OK to create the
buffer. Clip this buffer to the Shoreline Parcels layer, saving the file as
“LM_setbk.shp” and renaming the layer “Lake Michigan Setback.”
Remove buff_225.shp layer from the data frame. Visually examine the
impact of shoreline recession on nearby buildings and roads.
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Part II: Determining land and buildings at risk
Identify high risk land areas and buildings based on stabilization of the
slope at its current location.
Add the layer “age.shp” to your view. This layer was created by locating a
point on each parcel’s primary structure that is closest to the Lake
Michigan shoreline. Rename the layer “Shoreline Structures.”
There is room for improving the Buildings layer. The data for the Buildings layer is
classified into three categories: residential (from an aerial photo), agricultural and
buildings (surveyed). However, there are inaccuracies in the classifications for this data
set. In addition, the buildings could have been structured as polygons instead of multiple
line segments to make their display, coding and analysis more effective. A close look at
the features will illustrate the inconsistencies of the digitizing process. Because of these
problems, a new simplified layer (age.shp) was created for this application.
All land within this Current Stable Bluff layer is likely to become part of the bluff as it
stabilizes. You will now select all buildings within this area as “high risk” of being lost to
erosion processes.
Choose Select By Location from
Select menu. In the dialog, select
features from Shoreline Structures
that Intersect Current Stable Bluff
(Figure 14). Click Apply and close it.

Figure 14. Select By Location dialog box
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Right click on the Shoreline Structures layer and open it’s attributes table.
Click on the Options button at the bottom of the table and add a string
field called "Risk." Set Type to Text and change Length to 10 (Figure
15). One record should be highlighted for being at high risk. Right click
on the Risk field header and choose Calculate Values… in the context
menu. Click Yes to confirm it. Set this field equal to “High” (make sure to
include the quotation marks to identify this as a string expression) (Figure
16). Close the attributes table and clear the selection on the Shoreline
Structures layer by choosing Clear Selected Features from the Selection
menu. Save you document.

Figure 15. Add Field dialog box
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Figure 16. Field Calculator dialog box
You will use the Shoreline Structures layer to determine whether the buildings on a
parcel are impacted by bluff recession. You may recall that this point layer was created
by locating one point on the major building of each parcel that is closest to the lake. For
this analysis, you will assume that damage to this structure will result in the complete
loss of improvement values on the property. Obviously, this estimate does not account for
the value of other buildings on the property or partial damage to the primary building.
The database for this analysis could be improved by associating each building with a
separate value and by reformatting the building layer as polygons rather than line
segments.

Identify moderate risk land areas and buildings found between the
current stable slope location and the Ordinance setback zone.
Over the next 50 years, the Ordinance estimates that all the land within the setback zone
will be lost to erosion from shoreline recession and bluff stabilization. Therefore, land
areas and buildings between the Current Stable Bluff and the Lake Michigan Setback
locations can be considered to be at “moderate risk” from the impacts of recession.
You will make a simple subtraction of the smaller buffer (Current Stable Bluff) from the
larger buffer (Lake Michigan Setback) to create a new polygon identifying these areas of
moderate risk. And make a selection to identify at-risk buildings.
Note: You will need an ArcGIS 9 ArcInfo license to perform the “Erase” geoprocess. If
you are using an ArcView or ArcEditor license, you couldn’t perform this operation.
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Click Show/Hide ArcToolbox Window button to open the
ArcToolbox. Double click the Erase command under the Analysis
Tools and Overlay categories. In the Erase dialog box, choose Lake
Michigan Setback layer as Input Features and choose Current Stable
Bluff layer as Erase Features (Figure 17). Save the Output Feature
Class as “area_modrisk.shp.” Click OK to create a new layer. Rename it
to “Areas of moderate risk.”
Erase command can create a feature class by overlaying the Input Features
with the polygons of the Erase Features. Only those portions of the Input
Features falling outside the Erase Features outside boundaries are copied to
the Output Feature Class.

Figure 17. Erase dialog box
Choose Selection By Location from Selection. Select features from
Shoreline Structures that Intersect Areas of Moderate Risk (Figure 18).
Click Apply and close it. Open the attribute table of Shoreline Structures,
right click on the Risk field header, choose Calculate Values… to
calculate the Risk field equal to “Moderate” (Figure 19). Close the
attributes table and clear the selection. Save your document.
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Figure 19. Field Calculator dialog box
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Identify at-risk land areas and buildings within 50 feet of the setback.
One response to the threat of impacts from recession is to move the at-risk structures. In
order to move these buildings, land is needed on all sides of the structure for the
operation of moving equipment. It is estimated that at least 50 feet is needed on the side
of the building facing the lake for this undertaking. This translates to an additional 50 feet
of at-risk land inside the setback zone.
Create a 275-foot buffer of the Lake Michigan Shoreline layer, save the
buffer layer as “buff_275.shp”. Clip this buffer to the Shoreline Parcels
layer, saving the file as “at_risk.shp,” and renaming the layer “Moving
Area.” Remove the buff_275.shp file.
Use the Select by Location operation to select all Shoreline Structures
that intersect with the Moving Area. Then use the Select by Attributes
operation. In the dialog box, set layer as Shoreline Structures and choose
select from current selection as method. Build a expression as ( “Risk”
= ‘’ ) in the expression box (Figure 20). Click Apply and close it. Now,
open the attributes table of Shoreline Structures and calculate the risk field
for this new set equal to “At Risk”. Clear the selection on the Shoreline
Structures layer and save the document.

Figure 18. Select by Attributes dialog box
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Part III: Estimating the economic impact of recession.
Based on the location of the projected shoreline, you will estimate economic impacts to
assessed land values in the area. You will also estimate impacts to buildings and roads
from bluff edge recession. All these analyses will be based on the recession rate assumed
in the Shoreland-Floodplain Ordinance (i.e. two feet per year over a 50-year time frame).
For this analysis, you will be calculating the impact to lands based on the recession of
the shoreline. The actual amount of land lost depends on both the recession of the
shoreline cutting away the toe of the bluff, and the stabilization of the bluff causing
recession of the bluff edge. Therefore, the total land lost will likely fall somewhere
between the future shoreline location and the future bluff location.
Perhaps the best way to estimate this impact is to find the area between the current bluff
edge and the future stable bluff location for each parcel. This could be used to estimate
loss of land. However, your analysis will focus on a simpler operation – calculating the
economic impacts to land lost from only recession of the shoreline.

Estimate the amount of land lost from shoreline recession.
Use the select by location operation to select all parcels that are within
1000 feet of the shoreline (Figure 21). Save this layer as a shapefile by
choosing Data>Export Data under the context menu of Parcels layer
(Figure 22). Save this layer as par_shor.shp, add it to the view and rename
it “Shoreline Parcels.” You will be using this parcel layer for the
remainder of this section; delete the other Parcels layer from your view.
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Figure 22. Export Data dialog box
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Double click Intersect command under the Analysis Tools and Overlay
categories in the ArcToolbox window. Add Shoreline Parcels and 50-year
Shoreline layers as Input Features and set Output Feature Class as
“landlost.shp” with full path. Let other fields default values and create an
overlapping layer (Figure 23).
The Intersect command creates a shapefile with polygons formed wherever
two or more layers overlap. These polygons contain the attributes of
overlapping layers.

Figure 23. Intersect dialog box
Now, calculate the area of these new intersect polygons by adding a
numeric field (type Double) to the Attributes of Landlost table (Figure 24).
Name this field “Intersect Area.” (You may have to abbreviate the field
name.) Right click on the header of new field and choose Calculate
Values… In the Field Calculator, check the box of Advanced and type
four lines into the Pre-Logic VBA Script Code box: (Figure 25)
Dim Output as double
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Dim pArea as Iarea
Set pArea = [shape]
Output = pArea.area
Type in Output in the lower bottom text box and click OK to calculate
values (Figure 23). This intersection area represents the amount of land
lost in each parcel to recession over a 50-year interval (based on a
recession rate equal to two feet per year).

Figure 24. Add Field dialog box

Figure 25. Field Calculator dialog box
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Add a Float type number field (2 decimal places) named “landlost” to the
Attributes of Landlost table. Calculate this field equal to Intersect Area /
Sum_Area. The landlost field estimates the proportion of land lost from
the total area of the parcel.

Estimate the value of the land lost to shoreline recession.
You are now going to match each parcel’s spatial information with data on the assessed
value of the land. If you examine the data on land values, you will see that several
records may share a common parcel identification number. This is because a parcel may
be assessed in more than one category and the information is stored as multiple records.
For this application, you will need to aggregate all multiple records so each parcel has
only one total assessed value.
Both spatial and attribute information on the parcels must be aggregated to perform the
analysis described in these GIS applications. In both cases, information is “lost” for
analytical purposes when the individual records are combined under one parcel
identification number. Clearly there is value in planning for GIS analysis functions when
defining and refining database management systems.
Use any text file Editor to open the file “values63.txt” and replace “$” to
“_value” in the first line because ArcMap cannot recognize “$” as in the
fields. After editing, the first line looks like:
"Parcel_id","Category","Subcatgry","Acreage","Land_value","Improv_value"

Save the file and close the editor.
Add values63.txt to your data frame and open it.
Right click on the Parcel_id field header of the attributes table and choose
Summarize… in the context menu. Parcel_id field is the field used to
aggregate your data. In the dialog box, choose a directory and name for
your file (valu_sum.dbf). Check the following three summary fields, then
click OK: (Figure 26)
Field:
Acreage
Land_value
Improv_value

Summarize by:
Sum
Sum
Sum

Click Yes to add the result table in the map.
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Figure 26. Summarize dialog box
The new Valu_sum table will also be used to store data on the impact of
recession on shoreline parcel assessment value. Both the Landlost and
Valu_sum tables share common Parcel_id field values. With the join
operation, you will match and append records between tables through this
common identifier.
In performing the join operation, the Attributes of Landlost table will be
the source table, and Value_sum will be your destination table. Make sure
both tables are added in the map. Click Source tab at the bottom of the
Table of Contents. Right click on the Valu_sum table and choose Joins
and Relates>Join… Select Parcel_id field of two tables in the two fields
drop-down combo boxes. Select Landlost table as the table to join. Click
OK to join. (Figure 27)
When you execute a join, you are not affecting the physical files on the disk.
Rather, you are establishing a relationship between two tables. When you
save a project, you save the definition of this join in your view. Therefore,
next time you open the document, ArcMap will automatically rejoin the
tables. When you want to make changes in joined tables, you need to be in
the “home” table for the particular fields you wish to edit. Any changes you
make will be reflected in the destination table. You can also make a
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permanent disk copy of a destination table by exporting this table to a new
file.

Figure 27. Join Data dialog box
Add a double type number field called “lostvalu” to the Value_sum table
and
calculate
this
field
equal
to
[landlost.landlost]
*
[valu_sum.Sum_Land_v] (Figure 28). In other words, the lostvalu field
contains the loss in assessed value for each shoreline parcel, based on a
recession rate of 2 feet per year over a 50-year period. Now, right click on
valu_sum layer, choose Joins and Relates>Remove Join(s)> Remove
All Joins. Save your document.
This time with Valu_sum as the source table and Attributes of Shoreline
Parcels as the destination table, join the tables on Parcel_id (Figure 29).
Examine the data. Some of these parcels were not impacted by shoreline
recession and therefore show no loss of land value. In addition, remember
that two of the parcels are actually road right-of-way polygons and
therefore have no assessed values.
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Figure 29. Join data dialog box
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To summarize the total economic impacts to land values for the Town of
Mosel, narrow down your dataset to examine only those parcels
financially impacted by shoreline recession. Build a query on the joined
Shoreline Parcels layer to select for all parcels where
“valu_sum.lostvalu” > 0 (Figure 30).
Note that two parcels adjacent to the coast are not selected. These parcels have no
matches in the tax assessment database and may point out an error in that database.

Figure 30. Select By Attributes dialog box
To find the values for the Original Value field, you will need to open the
Attributes of Shoreline Parcels table (a subset of this table should be
selected). Right click on the header of Sum_Land_value field, choose
Statistics…under the context menu. A box will appear with summary
statistics for the Sum_Land_value field (Figure 31). You are interested in
the total value of the land for the selected set; this is the Sum. Note this
value. Now change the field to valu_sum.lostvalu, you will find the total
value of the land lost.
Clear the selected features from Selection menu and save your documents.
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Figure 31. Statistics window

Estimate impacts to buildings from bluff edge recession.
Bluff recession will impact buildings before shoreline recession. Therefore, the estimated
50-year bluff edge location, as projected from the Ordinance setback requirements, will
be used for this analysis.
Make the Shoreline Structures, Buildings, Lake Michigan Setback and
Lake Michigan Shoreline layers visible and the others invisible.
In order to obtain totals for improvement values (original and losses), you
will need to join the Valu_sum.dbf (source table) and the table for the
Shoreline Structures layer (destination table) on Parcel_id. For the
Original Values, use the statistics operation to calculate the total value
(sum) of the Sum_Improv_value field for these records.
Now you will determine which buildings are impacted from recession of
the bluff. From Selection menu, choose Select By Location to select all
points that intersect with the Lake Michigan Setback layer (Figure 32).
Open the attribute table for the Shoreline Structures layer. The selected set
will be highlighted; note the sum statistics for Sum_Improv_value field.
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Figure 32. Select by Location dialog box

Estimate the impacts to roads from bluff edge recession.
As with the buildings, recession of the bluff edge is a better predictor of impacts to roads
than shoreline recession.
Make the Transportation Routes, Lake Michigan Shoreline and Lake
Michigan Setback visible. Note how close the road (County LS) is to the
current bluff edge. You will be using the intersect operation to estimate
the length of road impacted by the bluff recession.
Right click on the Transportation Routes layer and select Properties…
Change to Definition Query page, build a query, selecting only records
with “LGDS_LEVEL” = 2. This narrows the layer down to just road
centerlines, therefore preventing multiple counting of impacts to the same
road section
Double click the Intersect command under the Analysis Tools and
Overlay categories in the ArcToolbox window. Add Transportation
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Routes and Lake Michigan Setback layers for the Input Features.
Choose a directory and name for your Output Feature Class
(lostroad.shp) and Click OK to perform the operation (Figure 33). Add the
result layer to the Shoreline Recession Scenarios data frame if ArcMap
doesn’t add it. Rename the layer “Road Impacts”.

Figure 33. Intersect dialog box
To find the total length of road impacted, open the attribute table for the
Road Impacts layer. Add a Double type number field called
“Impact_Len.” Right click on this field header and choose Calculator
Values… to open Field Calculator window. Click Advanced checkbox.
type the following four lines into the Pre-Logic VBA Script Code box
and type Output in the text box at the bottom of the window (Figure 34).
Dim Output as double
Dim pCurve as ICurve
Set pCurve = [shape]
Output = pCurve.Length

Click OK to calculate the lengths of the new line segments. To estimate
the total length of road impacted by bluff recession, use the statistic
function for a sum of the Impact_Len field. Save document.
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Figure 34. Field Calculator dialog box

Part IV: Estimating the volume of sediment lost to erosion.
Shoreline erosion also impacts water quality in Lake Michigan by adding tons of
sediment into the Lake. It is possible to estimate the volume of sediment that will be lost
to erosion based on the bluff height, the recession rate, the time frame under
consideration and the distance of shoreline under analysis. You will access the formula
for calculating sediment volume through ArcMap’s hot link tool.

Set up a hot link to the file containing the sediment loss formula.
Hot links provide a tool for linking a layer in your map with an external file. These
external files may contain text or images, or they may be used to access a customized
script file. You can even use this tool to documents, URLs or a Macro of ArcMap. In this
section, you will create a new layer that will act as a link to an image file containing the
formula for calculating sediment loss.
Click ArcCatalog button to open ArcCatalog. In the directory tree
view, locate a directory you wish to save the new shape file. Right
click on the directory and choose New>Shapefile… In the dialog box,
type in your filename as “sediment.shp” and choose Point Feature Type.
Click Edit button to select a predefined coordinate system, NAD 1983
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HARN Adj WI Sheboygan Feet, under Projected Coordinate
Systems>Country System>Wisconsin subdirectories. Click OK to close
the dialog box. Now, the shpefile is created in the directory. Close
ArcCatalog and return to ArcMap.
In ArcMap, add sediment.shp to your view. Click Editor Toolbar
button to open it. On the Editor Toolbar, click Editor button and
choose Start Editing. In Start Editing dialog, choose shapefile type and
click OK (Figure 35). Click Start Editing in the next dialog. On the Editor
toolbar, set sediment in Target drop-down combo box and Create New
Feature in Task drop-down combo box (Figure 36).

Figure 35. Start Editing dialog box

Figure 36. Editor Toolbar
Click Sketch Tool on the Editor toolbar. Place a point somewhere
along the Lake Michigan shoreline, just offshore. Save your edits
and rename the layer “Sediment Formula.” Open the Symbol Selector for
this layer by clicking on the legend in the Table of Contents. Choose a
new symbol for this layer (e.g. 16-point star). Clicking on this symbol will
access your hot link to the sediment formula.
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To create the hot link, open the table for the Sediment Formula layer. Add
a new Text field named “hotlink,” 50 characters in width. Edit the value in
this field by typing the pathway name to the file called “formula.gif.” For
example, this may look like: c:\coastgis\formula.gif. Save your edits and
stop editing from the Editor toolbar menu. Close the Editor toolbar
window.
Open the Layer Properties dialog box for the Sediment Formula layer
and change to Display page. Check the box in the Hyperlinks frame and
choose “hotlink” field in the drop-down combo box. Make sure Document
radio button is selected (Figure 37). Click OK to close the dialog box.

Figure 37. Layer Properties dialog box

Calculate the sediment loss from shoreline recession and bluff
stabilization.
With the Sediment Formula layer visible, click the Hot Link button.
Your cursor will now appear as a lightning bolt. Place the bottom of
the lightning bolt in the center of your Sediment Formula point and click
the left mouse button. A picture viewer should now appear in your view
displaying the sediment formula image file (Figure 38). Examine the
formula for computing the sediment loss.
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Figure 38. Sediment Loss Formula

Loss = (( r * t * h ) - ( 1.25 * h )) * l
where: h = bluff height
r = recession rate
t = time frame under consideration
l = length of shoreline under analysis
If the future stable bluff is located further inland than the
future bluff, use the formula:
Loss = (( r * t * h ) + ( 1.25*h*h )) * l

Four variables are necessary for calculating this value: height of the bluff (h), recession
rate (r), time frame under consideration (t) and length of area under analysis (l). For this
application, you will define these variables as: h = 50 feet, r = 2 feet/year and t = 50 years.
The length will be equal to the shoreline length for the Township. You may also wish to
calculate the sediment loss per mile of shoreline. If you decide to apply this formula to
another geographical area, remember to adjust the bluff height and recession rate values
accordingly.
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Open the table for the Lake Michigan Shoreline layer. Calculate the total
length of the shoreline by finding the sum statistics for the length field.
Note this value for your sediment loss formula. Calculate the sediment
loss value based on the stable slope described by the Ordinance setback
distance. You may wish to convert these values from cubic feet into cubic
yards (divide by 27). Save your document.
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5. Identifying parcels which may be difficult to
develop.
In this section, you will identify vacant parcels along the Lake Michigan shoreline which
may be difficult to develop under current zoning regulations.

Create buffer layers based on setback distances.
In this area of Sheboygan County, the setback requirements for all “Principle Buildings”
(e.g. homes, commercial buildings) along the Lake Michigan Shoreline is 225 feet from
the high water mark of Lake Michigan and 75 feet from any navigable inland waters
(with certain exceptions). In addition, Town of Mosel zoning requirements include an
80-foot setback from road centerlines.
Return to your Shoreland Zoning Ordinance data frame and view. For this
section, you will focus on the required setbacks within the zones, rather
than on the zones themselves. You already have a layer illustrating the
required Setback from Lake Michigan. Copy this layer from your
Shoreline Recession Scenarios view. Also copy the Transportation Routes
and Buildings layers from the Data Layers data frame.
With the Hydrography layer visible, create a buffer which illustrates a
setback zone of 75 feet for all inland waters. Save the file as “iw_sb.shp”
and Set buffer Distance 75 Feet. Select List as Dissolve_Type and check
Shpae field (Figure 39). Perform the operation. When the layer is added to
your view, rename it “Inland Waters Setback.”
Now, make the Transportation Routes layer visible. You will need to
narrow down this layer to show only road centerlines. In the Definition
Query page of Layer Properties window, build the following query:
( “LGDS_LEVEL” = 2 ) and click OK. Now, buffer this selected set with
an 80-foot buffer distance. Save the file as “rd_sb.shp” (Figure 40) and
rename the layer “Road Setback.”
Finally, you are going to create a layer with all three of these setbacks
merged into a single zone representing undevelopable lands. To do this,
you will need to use Union and Dissolve commands to merge the layers.
Double click Union command under the Analysis Tools and Overlay
categories in the ArcToolbox to open the window. Add Road Setback,
Lake Michigan Setback and Inland Waters Setback layers as Input
Features. Save your Output Feature Class as “nobd.shp.” (Figure 41)
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Figure 40. Buffer dialog box
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Figure 41. Union dialog box
Now, double click the Dissolve command under Data Management Tools
and Generalization categories in the ArcToolbox. Choose nobd as Input
Features and save Output Feature Class as “nobuild.shp.” Check Shape
filed in Dissolve_Field(s) list box and click OK to dissolve (Figure 42).

Figure 42. Dissolve dialog box
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Bring the new file into the view and rename it “Undevelopable Lands.”
Remove nobd.shp from the data frame since you will no longer need to
access any of the original buffers (all should end in .shp).

Calculate the amount of developable land for each parcel.
In order to narrow down this analysis, you will now select vacant parcels along Lake
Michigan. In order to select only vacant parcels, you will first select parcels with
buildings and then reverse this selection.
Make the Parcels layer visible and display it with a gray foreground and
with colored outlines. Choose Select By Location... in the Selection menu
to create a new set by selecting parcels that intersect with buildings
(Figure 43). Now, reverse this set to highlight vacant parcels by opening
the parcels layer table and clicking Switch Selection in the Options
context menu.

Figure 43. Select By Location dialog box
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Close the table and do another Select By Location.... Select from the
currently selected features in Parcels layer that are within a distance
of Lake Michigan Shoreline. Type 1000 feet for the selection buffer
distance. Click apply button to choose only from the previously selected
vacant parcels and close the window (Figure 44).

Figure 44. Select By Location dialog box
At this point, you can visually examine the impacts of the various
setback zones on vacant property. The Measure button is a tool for
obtaining measurements from the view screen. However, you may want to
obtain more exact measurements of developable land for each parcel.
Clear selected features from Selection menu. Click the Intersect command
in the ArcToolbox. Add Parcels and Undevelopable Land as the Input
Features. Save the Output Feature Class as “intrsect.shp” and click OK to
perform it (Figure 45). Rename the result layer “Intersection” in the Table
of Contents window. This file contains polygons representing the
undevelopable land for each parcel.
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Figure 45. Intersect dialog box
You can use these undevelopable lands to find the total developable area
for each parcel. First, add a Double type number field (named
“Inter_Area”) to the Attribute of Intersection table. Right click on header
of Inter_Area field and choose Calculate Values…. Check Advanced box
in the dialog and type the following 4 lines in the Pre-Login VBA Script
Code box:
Dim Output as double
Dim pArea as Iarea
Set pArea = [shape]
Output = pArea.area

Type Output in the text box at the bottom of the window (Figure 46).
Click OK button. This will calculate the area of the polygons in this
shapefile..
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Figure 46. Field Calculator dialog box
Now, with Intersect as the source table and the Parcels as the destination
table, join the tables on the field “Parcels_id” by right clicking on the
Parcels layer and choose Join…. Add a Double type number field to the
Attributes of Parcels called “Develop” and calculate this field equal to
[Parcels.SUM_AREA]. Once again, calculate this field equal to
[Parcels.SUM_AREA] - [Intersect.Inter_Area]. In other words, you are
calculating the amount of land in each parcel that does not fall into one of
the setback zones.
We do calculating value two times since some parcels have no overlap with the setbacks
layers and therefore, have no Intersection records. If there is no overlap with a setback
zone, a parcel’s total area is considered developable. So we first fill in
[Parcels.SUM_AREA] values, then calculate this field equal to [Parcels.SUM_AREA]
- [Intersect.Inter_Area]. The values of those parcels with no intersection records will
have the parcels’ area; otherwise, they will be filled in zero.

Chart the amount of developable land on vacant, lakeshore parcels.
Once again, you are going to restrict your analysis to vacant parcels, with
no buildings, within 1000 feet of the Lake Michigan Shoreline. With the
Parcels layer visible, use the Select By Location... operation to select this
set.
One way to examine this data is to make a chart illustrating the amount of
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developable land for each shoreline parcel. Open the Parcels layer table.
Click on the Options button and choose Create Graph. In the Graph
Wizard dialog boxes, first choose the type of your chart. Then, check the
field Develop and make graph data series use Fields. Name the title of
chart as “Developable Lands.” Set label legend with Parcel.id field. Click
Finish button. Your chart will now be displayed. A similar chart is like
(Figure 47). Now, your can use mouse cursor, clicking on the chart, to
query the attributes data.
You can also change formats of the chart by clicking the Advanced
Options… and Add Overlay… buttons in the wizard dialog boxes. You
can adjust Titles, Axis, Font, Markers, Background… and etc.

Figure 47. Developable Lands chart

Flag vacant, lakeshore parcels with minimal developable lands.
Although visual interpretation of maps and charts will give you an overall view of this
issue, you may want a more qualitative solution to help you with your decisions. In this
section, we will flag parcels will less than 25,000 available square feet for development
as “parcels for potential concern.” The 25,000 square feet value is somewhat arbitrary; it
is simply intended to represent a value for which sitting a home may be more difficult.
These may be parcels where zoning administrators will pay extra attention when
evaluating any submitted permits. However, feel free to change this value if 25,000 does
not make sense to you.
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The vacant, lakeshore parcels without buildings should be highlighted.
Create a query on this layer, selecting from the current selection any
parcels with less than 25,000 feet of developable land. Only show these
records by clicking the Selected button in the attributes table. Add a Text
field to the Parcels layer called “Flagged.” Calculate values of this filed
equal to “Yes”. Open the layer properties dialog box and change to Labels
page. Check the box in front of Label features in this layer and choose
Parcels.Flagged in Label Field drop-down combo box. Make other values
in default values. Click OK. You will find that these parcels are labeled
with Yes.
The accuracy of these buffers in determining setback distance is only as good as the
accuracy of the lines on which they are based. Any user of these model applications
should be aware of the following data limitations and the assumptions made in this
analysis:
1. The Shoreland-Floodplain Ordinance requires a 75-foot setback from the ordinary
high water mark for all inland navigable waters. In this analysis, you made two
assumptions that could be challenged: (1) all inland waters are navigable, and (2) the
rivers and streams can be portrayed by one “centerline” (rather than their two
shorelines).
2. The Town of Mosel Zoning Ordinance requires a minimum setback of 80 feet from
road centerlines, with a 100-foot requirement for state and federal highways.
However, the digitized road segments do not differentiate between county, state,
federal or “unofficial” (e.g. military base) road segments. Your 80-foot buffer will be
inappropriate in some places.
3. As you know, the dynamic nature of the Lake Michigan shoreline makes it a difficult
feature to digitize accurately. The location of the ordinary high water mark, the basis
for this setback, is not static. Therefore, the setback cannot be static.
4. Without information describing the creation of this digitized shoreline, we cannot be
certain whether the digitized line represents the ordinary high water mark, the
location of the water’s edge at the time an aerial photograph was taken, or some
other feature that was interpreted as the “shoreline.” This type of background
information about a GIS data feature is called “metadata” and should always be
recorded when a GIS layer is created!
Save your document.
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permit

In this section, you will evaluate aerial photographs and permit information to identify
whether structures along the Lake Michigan shoreline are in compliance with the
shoreland permit regulations.

Evaluate aerial photographs to determine the age of structures.
Old aerial photographs of Sheboygan County are a good source for tracking the
development of this area over the last sixty years. From these photos, it is possible to
determine the approximate age of the structures along the shoreline. Of particular
importance to this application is the date October 27, 1970. Structures built prior to this
date are considered “non-conforming” uses if they do not meet current requirements of
the zoning districts. Structures built after the effective date of the ordinance that do not
meet the requirements of the ordinance and do not possess a proper variance or permit
may not be compliant. In these cases, further investigation may be warranted. Aerial
photos from the years 1941, 1961, 1967, 1971, 1978 and 1992 were used to determine the
age of major structures within 1000 feet of the Lake Michigan Shoreline. In the Shoreline
Structures layer, the field “When_built” contains the range of years when buildings first
appeared in the location of the point.
Copy the Shoreline Structures layer from the Shoreline Recession
Scenarios data frame into your Shoreland Zoning Ordinance data frame
and make the frame active. Use the Select By Location... operation to
select all of the shoreline structures that intersect with the Lake Michigan
Setback layer. To find out if any of these structures were constructed after
the ordinance went into effect, use Select By Attributes… Select from
current
selection
and
build
the
following
query:
"AGE.WHEN_BUILT" = '1972 - 1978' OR "AGE.WHEN_BUILT" =
'1978 - 1992'. Click Apply and close it. Two points should be highlighted.
Now you will see if these two structures have shoreland permits. Add the
table “moselplg.dbf” to your document. Using moselplg.dbf as the source
table and Attributes of Shoreline Structures as the destination table, join
the tables on the Parcel_id field. You will note that neither of the selected
structures have permits. Therefore, further review may be warranted to
determine if they are in compliance with the Ordinance. Save your
document.
This application points out the difficulties in working with a changing feature like the
Lake Michigan Shoreline. If the shoreline was a farther distance away when these
buildings were constructed, they may have been in compliance with the ordinance at that
time. Using photogrammetric techniques, you could determine the distance of these
structures from the shoreline at the time the photos were taken.
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7. Informing landowners about septic tank
regulations.
In this section, you will generate a form letter, asking landowners for information about
their septic systems.

Link attribute files containing information on parcels, sanitary systems
and land ownership.
Return to your Data Layers view. Add the dBase file called
“moselsan.dbf” and “ownerwww.dbf” to your document. Both these
attribute files share the Parcel_id field in common with the Parcels layer.
With the ownerwww.dbf file as the source table and the Attributes of
Parcels as your destination table, join these tables.
Perform a second join using the moselsan.dbf as the source table and the
Attributes of Parcels as the destination table. Once again, use Parcel_id as
the common field.
In order to make the Attributes of Parcels table less complicated, you can
hide some of the fields from Layer Properties. Open the layer properties
dialog box, change to Fields page and uncheck any fields which you wish to
hide. These fields won’t appear if you print the table. In addition, they can’t
be used to label or query the layer.

Display developed parcels without sanitary permits.
Make the Parcels and Buildings layers visible and other layers invisible.
Display the Parcels layer in gray, outlined by another color. Clear any
selection you may have on this layer.
You will now find all the parcels that are developed (i.e. overlap with the
Buildings layer). Under the Selection menu, choose Select By Location....
Select the features from Parcels layer that Intersect Buildings layer.
(Figure 48) Click Apply and close it. Convert these features to a shapefile
by right clicking on the Parcels layer and choosing Data>Export Data…
Save the file as “developed.shp” and add the file to your view and rename
it “Developed Parcels.” (Figure 49) Click the Clear Selected Features for
the Selection menu.
Make the Developed Parcels layer visible. In order to select only the
parcels without sanitary permits, we will first select those with permits and
then reverse the selection. In the attribute table of Developed Parcels layer,
under the Options context menu, choose Select By Attributes. Build the
following query: ( “SANPERMIT” > 0 ). Click Apply and close it. Now
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click the Options button and choose Switch Selection. All of the parcels
with buildings, but without recorded sanitary permits, will be highlighted.
Save your document.

Figure 48. Select By Location dialog box

Figure 49. Export Data dialog box
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Mail merge ownership data with a form letter using Microsoft Word.
For this section, a form letter called “notify.doc” has been created. This letter is intended
to illustrate the capabilities of coupling the GIS and word processing functions. Feel free
to edit the letter and insert additional merge fields to make this exercise more relevant to
your applications.
First, you need to save your current selection as a dBase file. Make sure
your Attributes of Developed Parcels table is open. To export the database
file, click the Options button and choose Export… Export your Selected
records and save your output file as “notify.dbf.” Save your document,
minimize the ArcGIS screen and open Microsoft Word.
Open the file “notify.doc.” In the Tools menu, select Mail Merge. From
the Mail Merge Helper box, under Step 1 -- Main Document, choose form
letters from the Create drop-down menu. A question box will appear;
click Active Window.
Proceed to Step 2. Select Open Data Source under the Get Data
dropdown menu. From the List of Files Type, choose the dBase(*.dbf)
option. Select “notify.dbf” and click OK. In the Confirm Data Source
dialog box, highlight your appropriate dBase connection and click OK. A
question box will appear stating that no merge fields have been identified;
click the Edit Main Document button. Place the cursor below the line
“Sheboygan County Property Owner.” From the Insert Merge Field scroll
list, select STREET. Move to the next line and add the merge field CITY.
Now, type a comma followed by a space and the letters “WI” and two
spaces. Add the merge field ZIP5.
To proceed with the final step, choose Mail Merge from the Tools menu.
Under Step 3, click Merge.... The Merge Box will appear; simply click the
Merge button and the program will produce 263 separate form letters for
all of the affected properties. Save your letters.

